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Recommended System Requirements 
PC-DMIS Q-DAS Interface consists of these tools: 

• Q-DAS Configurator 

• Q-DAS User Interface 

These tools are installed when you install PC-DMIS Q-DAS Interface. 

Operating System 
PC-DMIS Q-DAS Interface operates under the following: 

• Windows XP 

• 32-bit Vista 

• 32-bit and 64-bit Windows 7 

• 32-bit and 64-bit Windows 8.1 and 8 

No other operating systems are supported. 

PC-DMIS Q-DAS Interface 
PC-DMIS Q-DAS Interface version 2.2 installed. 

Catalog File 
An appropriate catalog file that contains catalog definitions. 

PC-DMIS 
For the recommended system requirements for PC-DMIS, refer to the PC-DMIS Readme 
document. 
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Installing PC-DMIS Q-DAS Interface 
To install PC-DMIS Q-DAS Interface, follow these steps: 

Step 1: Check System and Hardware Requirements 
Before you attempt to install a new PC-DMIS Q-DAS Interface version, ensure that you meet 
the system and hardware requirements discussed in "Recommended System Requirements". 
Your IT specialist can help you with this information. 

• To get your computer's properties, highlight the My Computer icon, right-click on it, and 
select Properties. 

• To check the display properties for the graphics card, select Start | Settings | Control 
Panel, and then select Display and Settings. 

You must also have a USB portlock or a valid software license for the installation to work. 

Step 2: Log On as an Administrator 
To install and run your new PC-DMIS Q-DAS Interface version for the first time, you must be 
logged on as a user with administrator privileges. 

Step 3: Install PC-DMIS Q-DAS Interface 
The following steps run you through a typical installation. Your installation screens may differ if 
you are running a different version of PC-DMIS Q-DAS Interface. In addition, your license may 
be configured with different options. 

1. Locate the PC-DMIS Q-DAS Interface install file on your installation media; or, if you 
downloaded it, open the directory containing the downloaded file. The install file looks 
like this: 

Q-DAS_Release_#.#.###.#.exe 

The # symbols represent the specific version numbers and the version type (x64 or x86). 

2. Double-click this executable to begin the installation process. If presented with a security 
warning, click Run. 

The files are extracted to a temporary directory: 
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The Choose License Type screen appears: 

 
  

3. Select one of the following license types: 

• HASP - If you have a physical USB portlock, ensure that it is connected to your 
computer, and then select this license type. It is selected by default. 

• LMS (Software) License - If you have been issued a software license (called an 
Entitlement ID), or if you are connecting to a local license server, select this 
license type. 

4. Click Next to proceed. The main setup interface then appears. Click Next to start the 
installation: 
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5. The Choose Setup Type screen appears. Choose a setup type: 

 
  

• Typical - This option installs the program files to the default installation location: 

C:\Program Files (x86)\WAI\PC-DMIS Q-DAS 2.2 (Release) 
• Custom - This option lets you specify what components to install as well as 

customize the installation location. A screen similar to the following screen 
opens: 
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Overview of Customizing Installed Features 

By default, all program components are selected to be included in the installation. 
You can use the tree view to customize when or if these features are installed. To 
do this, click the small drop-down icon  next to the component to exclude. This 
list appears: 

 
  

Choose the desired option: 

• Will be installed on local hard drive - The selected feature is installed 
to the hard drive on your computer. 

• Entire feature will be installed on local hard drive - The entire feature 
is installed to the hard drive on your computer. This means that sub-
features of the selected feature are also installed. 

• Will be installed to run from network - This option is currently 
unsupported. This option installs the selected feature on a network share. 

• Entire feature will be installed to run from network - This option is 
currently unsupported. This option installs the entire component to a 
network share. This means that sub-features of the selected feature are 
also installed. 

• Feature will be installed when required - The feature is only installed if 
required during the installation process. Some files are informational and 
are not required for the application to run. These may include 
documentation or other files. 

• Entire feature will be unavailable - This option excludes the component 
from installation. 

  

Customizing the Installation Location 

To change the default location, click the Browse button and navigate to the 
directory on your computer that you want to hold the program files. When you click 
OK, the Location box changes to show the selected location. 

If you ever want to reset the items to the default selection, click Reset. 
Click Next when you have finished customizing the install. 



PC-DMIS Q-DAS Interface 2.2 Release Notes 

6 

6. Once the installation has all the information it needs, the Ready to Install screen opens: 

 
  

7. Click Install to proceed with the main installation. 

8. Once the installation finishes, this final screen appears: 

 
  

9. Click Finish to close the installation program. The Q-DAS Configurator and Q-DAS User 
Interface tools are now installed. 

If you chose LMS (Software) License in the Choose License Type dialog box, and the 
installation process cannot find a valid license on your system, a message appears and 
indicates that your LMS license is not activated: 
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If you were issued an LMS software license (called an Entitlement ID) and did not 
activate it when you installed PC-DMIS, or if you purchased PC-DMIS Q-DAS Interface 
after you purchased PC-DMIS, you will need to activate the license through the Client 
License Administrator (CLM) application (clmadmin.exe). This application is located in 
the following folder: 

C:\Program Files\WAI\CLM 1.3 (Release) <##-bit> 
Where <##> is either 32 or 64. 

For help with using the CLM application, consult the PC-DMIS CLM Licensing Software 
documentation (pcdmisclm.chm). This documentation is located in the PC-DMIS 
language subdirectory. 

Administrator Privileges Explained 
The PC-DMIS Q-DAS Interface installer has a flag built into the setup executable file that 
requires the setup process to run with administrator privileges. If the current user has lesser 
privileges, the setup displays a prompt to provide a user name and password of an account with 
administrator privileges. 

Once the installation finishes, the first time you run Q-DAS Configurator or Q-DAS User 
Interface, you must launch it with administrator privileges. 

Step 4: Launch the PC-DMIS Q-DAS Interface Tools 

Important: Running the PC-DMIS Q-DAS Interface tools inside a Virtual Machine (VM) is not 

supported. 

PC-DMIS Q-DAS Configurator 
To launch the PC-DMIS Q-DAS Configurator tool: 

1. Do one of the following: 

• Choose Start, All Programs, PC-DMIS Q-DAS <version> (Release), and then 
Q-DAS Configurator. 

• Right-click on the Q-DAS Configurator icon on your desktop, and then select 
the Run as administrator option. 

 
  



PC-DMIS Q-DAS Interface 2.2 Release Notes 

8 

The startup screen appears. The software also checks your portlock options and 
displays a message on the startup screen. For example: 

 
  

If your portlock is not programmed correctly, an error message appears and the tool 
does not run. 

If your portlock is programmed correctly, the Registration dialog box appears: 

 
  

2. Do not change the user name; it must be Programmer. 
3. Type the password in the Password box. If you type an incorrect password, the 

Password box turns red. 

4. Click OK. The Q-DAS Configurator dialog box appears. 
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PC-DMIS Q-DAS User Interface 
To launch the PC-DMIS Q-DAS User Interface tool, do one of the following: 

• Choose Start, All Programs, PC-DMIS Q-DAS <version> (Release), and then Q-DAS 
User Interface. 

• Right-click on the Q-DAS User Interface icon on your desktop, and then select the Run 
as administrator option. 

The startup screen appears. The software also checks your portlock options and displays a 
message on the startup screen. For example: 

 
  

If your portlock is not programmed correctly, an error message appears and the tool does not 
run. 

If your portlock is programmed correctly, the Q-DAS User Interface dialog box appears. 
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Modifying, Repairing, or Removing the Installation 
You can also modify or repair an installation as needed once it is installed. To do this, double-
click on the Q-DAS_Release_#.#.###.#.exe file as if you were beginning the installation 
process. The setup displays the Modify, Repair or Remove installation screen with these 
options: 

 
  

• Modify - This option opens the Custom Setup screen as discussed in "Step 3: Install 
PC-DMIS Q-DAS Interface". Use this option to change the installed features, either by 
adding something that was previously not installed or removing a software feature that 
you no longer need. 

• Repair - This option reinstalls all of the product files as they were originally installed. 
This option may help resolve issues where an installation didn't properly install all of the 
files. 

• Remove - This option removes the application from where it was installed. You can also 
uninstall the application using the Programs and Features control panel item in Control 
Panel. 
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Running the PC-DMIS Q-DAS Interface Tools in another Language 
The initial installation setup file for PC-DMIS Q-DAS Interface contains the user-interface files 
for all of the supported languages. When you install PC-DMIS Q-DAS Interface, it installs the 
language files based on your operating system's language. 

To run a PC-DMIS Q-DAS Interface tool in a language other than the operating system's 
language: 

1. Click the File menu, point to Language, and then click the desired language. 

2. At the prompt to change the language and restart the user interface, click Yes. 

The tool restarts and displays the application in the desired language. 

Installing Non-English Help Files from Language Packs 
The English help files are the only help files included in the main installation package. They are 
installed regardless of the installation language. However, non-English help files are not 
included in the main installation file. 

This means that if you install a non-English language or if you switch to a non-English language, 
in order to see any help content at all, you must also install a language pack for that language. 
Otherwise, if you try to access the help file, PC-DMIS Q-DAS Interface displays an error 
message indicating that it cannot find the help file. 

A language pack contains all of the help content for that language. 

To install a language pack, do the following: 

1. Locate the desired language pack (and .exe file) on your installation media or download 
it from the Internet here: 

ftp://ftp.wilcoxassoc.com/PC-DMIS-QDAS-Interface/Release/2.2/ 
2. Run the .exe file and follow the setup instructions. You do not need to have administrator 

access to do this step. 

This procedure installs the help content into the appropriate two-letter language subdirectory 
where you have PC-DMIS Q-DAS Interface installed. You can then switch to that language in 
the software and access the help content. 

Troubleshooting 
For information about troubleshooting installation, startup, and software update problems for 
PC-DMIS, refer to the PC-DMIS Readme document (Readme.pdf). 
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Information about this Release 
We at Hexagon Metrology are proud to bring you this new version of PC-DMIS Q-DAS 
Interface. This Enterprise Metrology Solutions platform brings together new aspects of PC-DMIS 
Q-DAS Interface for the development of a complete manufacturing process control solution. 
Available in this release are variations of PC-DMIS Q-DAS Interface designed to assist with 
every aspect of the fabrication and quality control process. The newly created packages include 
the established PC-DMIS Q-DAS Configurator and PC-DMIS Q-DAS User Interface modules. 

The testing of this version has been significant. We’d like to take a moment to discuss this 
process and also make you aware of the various components of testing. 

Testing is comprised of two parts. These can be described as functional testing and integration 
testing. The vast majority of testing effort goes on in the functional area. This is the testing that 
determines that specific functions that are core to the software, regardless of what type of 
machine is used, are working correctly. The integration testing is essentially a testing of the 
interface with a particular type of machine. 

In the ideal scenario, Hexagon Metrology would have access to at least one of every piece of 
hardware that is operating in the field running Q-DAS. However, in practical terms, this is 
impossible. This integration test plan is then performed on as many types of machines as we 
have available. 

Should you experience problems with your system after you install PC-DMIS Q-DAS Interface, it 
could possibly be an integration problem. If it is a problem of this nature, it will probably be 
evident immediately upon first use of the possibly untested configuration. See "Contact 
Hexagon Metrology" on how to report any integration problems. Should such a problem 
materialize on a commercial release, you will be given the highest priority for correcting these 
problems. 

For existing users of PC-DMIS Q-DAS Interface who currently have earlier versions installed, it 
is advised that PC-DMIS Q-DAS Interface be installed into a new directory. In this way, you can 
be assured of continuous use of the existing version should problems arise with this newer 
version. 
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New Product Information 

2.2 Release 
Release date: February 20, 2015 

For a listing of the enhancements and fixes for PC-DMIS Q-DAS Interface 2.2, refer to "Release 
Notes". 

"Part Program" Terminology Change 
Starting with version 2.2, a "part program" is referred to as a "measurement routine". 
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Release Notes 
Version PC-DMIS Q-DAS Interface 2.2 offers significant enhancements over the previous 
version, the PC-DMIS Q-DAS Converter. 

Featured Items 
This new version supports the following: 

• All 135 keys specified in the Automotive Quality Data Exchange Format (AQDEF) 

• Studies that you can create to collect data for specific analysis 

• A flexible user interface 

• Different write file modes, which enable you to specify how files are written 

• New PC-DMIS 4.3 Toolkit Functions 

Additional enhancements: 

• Added the ability to use the Q-DAS Configurator tool as the editor of the Q-DAS data file. 

• Improved the Update feature for the Q-DAS data file. 

• Added GM rules for the K2001 and K2002 fields. 

• Added the ability to identify duplicate values for the K2001 field. 

• Added support for Feature Control Frame (FCF) GD&T dimensions. 

• Added support for multiple catalogs with the user interface. 

• Added the ability to find and replace a keyword in the Q-DAS data file. 
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Q-DAS Configurator Tool 

Enhancements 
• QDAS-89 - Reorganized the options on the File menu in the Q-DAS Configurator 

dialog box to be user-friendly and useful for large projects. 

• QDAS-198 - Added the ability to quickly find a specific value in the Characteristics data 
area in the Q-DAS Configurator dialog box. To use this feature, select Edit | Find and 
Replace, and then complete the Quick Find and Quick Replace tabs in the Find and 
Replace dialog box. 

• QDAS-205 - Changed the Find Next button in the Find and Replace dialog box so that 
the "find" operation continues from the row in the Characteristics data area in which the 
cursor is currently located. 

• QDAS-202 - Added the "The file was changed, do you want to save it?" message. This 
message appears when you open, create, or update a Q-DAS data file; select File | 
Exit; or select the Close button. 

• QDAS-203 - Added the "Current Part Program in PCDMIS does not match Q-Das Data 
File. Please open matching part program and retry Update." message. This message 
appears if the measurement routine is already open in PC-DMIS and you are attempting 
to update the data in the Q-DAS Configurator tool. 

• QDAS-223 - Added GM naming rules to the K2001 field (the characteristic number) in 
the Characteristics data area. Application engineers can name features and 
dimensions in a measurement routine per this rule, and then use this option to quickly 
create the K2001 characteristic number as required by GM. 

• QDAS-318 - Added GM naming rules to the K2002 field (the description of the 
characteristic) in the Characteristics data area. Application engineers can name 
features and dimensions in a measurement routine per this rule, and then use this option 
to quickly create the K2002 characteristic description as required by GM. 

• QDAS-241 - Added a default K-field configuration file, which is named 
DEFAULT.QDASCFG.xml. This file is installed with the Q-DAS Configurator tool. 

• QDAS-252 - Improved the Update feature (File | Update). 

• QDAS-661 -  Added the Locate option to the Update dialog box. You can use this 
option to view the data for an item before it was modified in a measurement routine or 
removed from the measurement routine. To use it, right-click on a modified or removed 
item in the Items to be updated area in the dialog box. A shortcut menu appears with 
the Locate option; when you click this option, the item becomes highlighted in 
the Characteristics data area. 

• QDAS-667 - Changed the modified values that appear in the Update dialog box to red 
so that they are easily visible. 

• QDAS-279 - Added the Recent Files option to the File menu in the Q-DAS 
Configurator dialog box. To display the names of the Q-DAS data files that you 
previously opened, select this option. 

• QDAS-300 - Added the QdasCatalogFileParser.exe file, which you can use to either 
parse a catalog before you execute a measurement routine, or parse a catalog by using 
an external command in the PC-DMIS measurement routine. 
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• QDAS-346 - Changed the maximum length of the K0006 field to 20 characters. 

• QDAS-383 - Added support for LMS licensing. 

• QDAS-479 - Added the Duplicate Check for K2001 option to the Edit menu on the 
menu bar. If you select this option, the tool immediately checks for duplicates in the 
K2001 field. Otherwise, it checks for duplicates when you perform a save or select the 
option again. 

• QDAS-404 - Added the ability to save the Q-DAS data file if it contains duplicate values 
for the K2001 field. Also added a status message and progress bar, which appear while 
the tool is verifying duplicate entries for the K2001 field. 

• QDAS-501 - Added the ability to display the help topic for a dialog box by pressing F1. 

Fixes 
• QDAS-1 - Fixed an issue where the tool did not update the K2002, K2112, and K2113 K-

fields when the Update feature (File | Update) was used to update an existing Q-DAS 
data file. 

• QDAS-18 - Fixed an issue where a Profile Surface Dimension in a measurement routine 
appeared in the Q-DAS data file as a profile line. 

• QDAS-30 - Fixed an issue where the value for the K2404 field was incorrectly expressed 
in scientific notation in the .dfd file. 

• QDAS-31 - Fixed an issue where legacy dimensions were not tagged with a K2030/K2031 
value to group the dimensions together. 

• Fixed an unhandled exception error that appeared when: 

• QDAS-32 - The Create Q-das Data File toolbar button was selected to create a 
new Q-DAS data file for a measurement routine. 

• QDAS-113 - A list in the File Number column in the Characteristics data area 
was selected. 

• QDAS-424 - A value in the Order In File column in the Characteristics data 
area was added, edited, or deleted. 

• QDAS-431 - The OK button in the Key Settings for Studies dialog box (Setup | 
Key Settings for studies) was selected. 

• QDAS-502 - Ctrl+Delete (or Delete) was pressed in the Characteristics data 
area, the "Are you going to delete selected characteristic data?" message 
appeared, and then Yes was selected. 

• QDAS-38 - Fixed an issue where the tool displayed the wrong nominal value when it 
read data from the measurement routine according to where the cursor was placed in 
the Edit window in PC-DMIS. 

• QDAS-97 - Changed the diameter symbol to Ø. 

• QDAS-98 - Fixed an issue where the legacy profile of a surface feature type for the 
K2009 field was incorrect. 

• QDAS-100 - Fixed an issue where the tool stopped responding when Help | About was 
selected. 
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• QDAS-106 - Fixed an issue where data from the Q-DAS data file did not appear in the 
Characteristics data area, and the Save button on the menu bar was unavailable, 
when the file was opened and the measurement routine was already open in PC-DMIS. 

• QDAS-110 - Decreased the amount of time that the tool requires to load data into the 
Characteristics data area. 

• QDAS-126 - Fixed an issue where the measurement results were incorrect when the 
K2002 field was set up to be read from a PCD_COMMENT command in the K-field 
configuration file. 

• QDAS-208 - Changed the "Not Unique ID" message so that it no longer appears when 
you double-click in a cell in the K-field table in the Setup for K-field configuration 
dialog box (Setup | K-Field Setup) and type the same value in the cell. 

• QDAS-209 - Fixed an issue where the tool stopped responding when a value was 
changed in the Characteristics data area, File | Close was selected, the Yes button 
was selected to save the Q-DAS data file, and then the Close button in the upper-right 
corner of the Q-DAS Configurator dialog box was selected. 

• QDAS-222 - Fixed an issue where the tool did not check for duplicate entries if the For 
all marked feature was used to copy the K2001 field's value to multiple cells in the 
Characteristics data area. As a result of this fix, you can no longer copy and paste the 
same value to multiple cells. 

• QDAS-265 - Fixed an issue where a cell in the K-field table in the Setup for K-field 
configuration dialog box did not highlight when the value in the cell was changed to 
match the value in a different cell. 

• QDAS-271 - Fixed an issue where the tool incorrectly used a comma as a separator for 
numbers greater than or equal to 1000. 

• QDAS-297 - Fixed an issue where an error appeared, and the .dfq, .dfd, and .dfx files 
did not generate, when the measurement routine contained more dimensions than the 
Q-DAS data file. 

• QDAS-317 - Fixed an error where the tool incorrectly highlighted different values in the 
Characteristics data area as duplicates. 

• QDAS-338 - Decreased the amount of time that the tool requires to change an edited 
value for the K2001 and K2002 fields in the Characteristics data area. 

• QDAS-344 - Fixed an issue where the shortcut menu did not appear when right-clicking 
on a value in the Characteristics data area until the Q-DAS data file was saved, closed, 
and then reopened. 

• QDAS-395 - Fixed an issue where the tool did not display an error message to indicate 
that the calculated value for the K2001 field may have exceeded the maximum length for 
this field. 

• QDAS-402 - Fixed an issue where the tool did not display any values in the 
Characteristics data area when Setup | K-Field Setup was selected, and then File | 
Exit was selected in the Setup for K-field configuration dialog box to return to the 
Characteristics data area. Also fixed an issue where the data did not appear when an 
.xml file was selected in the K-Field configuration list in the Q-DAS Configurator 
toolbar. 
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• QDAS-405 - Fixed an issue where the tool did not properly sort the data in the K2001 
column in the Characteristics data area when the column header was clicked. 

• QDAS-428, QDAS-430 - Fixed an issue where the tool stopped working, and the status 
bar did not update, when a large Q-DAS data file was opened. 

• QDAS-429 - Decreased the amount of time that the tool requires to delete a value from 
the Characteristics data area when the Delete key is pressed. 

• QDAS-469 - Fixed an issue where an incorrect folder and file name appeared in the 
Save As dialog box when File | Save As was selected. 

• QDAS-535 - Fixed an issue where the separator that was previously selected in the 
Separator list in the Interface Setup dialog box (Setup | Interface Setup) did not 
appear after OK was clicked in the dialog box and then the dialog box was reopened. 

• QDAS-643 - Fixed an issue where the tool stopped responding when a K-field 
configuration file was selected in the K-field configuration list in the toolbar at the top of 
the Q-DAS Configurator dialog box. 

Q-DAS User Interface Tool 

Enhancements 
• QDAS-132 - Created a new WIX installer. 

• QDAS-501 - Added the ability to display the help topic for a dialog box by pressing F1. 

• QDAS-590 - Removed the path name of the Q-DAS catalog from the Qdas Catalog 
Setup dialog box (Setup | Setup for Q-DAS catalog file). 

Fixes 
• QDAS-7 - Fixed an issue where the K0053 field was missing from the .dfd and .dfx files 

when the field's value was configured in the Setup for K-field configuration dialog box 
(Setup | K-Field Setup) to be from a PC-DMIS measurement routine TRACEFIELD 
command. 

• QDAS-575 - Fixed an issue where the study name in the New Study Name box (File | 
Open) incorrectly displayed the name of the last study that was started instead of the 
study that was interrupted and then restarted. 

• QDAS-600 - Fixed an issue where the study name could not be modified. 
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Contact Hexagon Metrology 
If you are using the commercially released version of PC-DMIS Q-DAS Interface and would like 
further information or technical support, please feel free to contact 
http://hexagonmetrology.us/contact-us or visit www.pcdmis.com. Hexagon Metrology Technical 
Support can also be reached by calling (1) (800) 343-7933.

http://hexagonmetrology.us/contact-us
http://www.pcdmis.com/
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